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This file lists all changes made to ETABS since the previous version. Most changes do not affect most users. 

Incidents marked with an asterisk (*) in the first column of the tables below are more significant and are included in the 

ReadMe file. 

Changes from v13.1.1 (2013-07-22) 

User Interface 
Enhancements Implemented 

* Incident Description 

 38267 An option to "Add Copy of Property" has been added to the Link/Support Property definition form. 

 58056 An enhancement has been implemented that adds the perimeter, centroid, and polar moment of 

inertia (Ix + Iy) to the information shown in the right-click form for shell objects. 

 
Frame Design 

Enhancements Implemented 

* Incident Description 

 56120 An enhancement has been implemented for steel frame design where more detailed section 

properties are being reported for L-shaped sections. These properties include Imax, Imin, Smax, 

Smin, rmax, rmin, Ixy, and the principal rotation angle. The affected design codes are: AISC 360-

10, AISC 360-05, EC 3-2005, Italian NTC 2008, Indian IS 800:2007, NZS 3404-1997, and 

AS4100-98. 
 57599 The AS 3600-09/NZS 3101-06 codes for concrete frame and shear wall design and the AS 4100-

1998/NZS 3404-1997 codes for steel frame design have been updated for lateral load combinations 

by incorporating Amendment No. 3 in 2011 where the combination load factors for live load 

combined with seismic loads has changed from 0.4 to 0.3. 

 58100 For composite beam design using the AISC 360-10 code, the default value for "Camber Abs Max 

Limit" has been changed from 4 inches to 2 inches, and the default value for "Camber Max Limit, 

L/" has been changed from 180 to 300. The new default values are selected based on AISC 2010 

"Design Examples version 14.0" and the AISC Design Guide 3. These limits are available as 

options in the Design Preferences and can be changed from the default values as needed. 

Shear Wall Design 
Enhancements Implemented 

* Incident Description 

 56569 The following enhancements were added to the Eurocode 2-2004 (EC2) shear wall design for 

uniform reinforcing and section designer section options: (1) The geometric imperfection and 

minimum eccentricity requirements are now checked in accordance with EC2 section 5.2(7) and 

6.1(4) respectively. (2) The slenderness of the wall is computed in accordance with EC2 section 

5.8.3.1. Two methods are available for computing the moment magnification due to Second Order 

Method, namely nominal stiffness (Section 5.8.7) or nominal curvature (Section 5.8.8). (3) 

The design manual has been updated. 
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Results Output and Display 
Enhancements Implemented 

* Incident Description 

 58948 The output table Modal Direction Factors for the modal load cases has been enhanced to include the 

contribution of all mass in the structure. Previously the direction factors were calculated only for 

mass included in rigid diaphragm constraints. Now all mass at each story level is considered as if it 

was part of a rigid diaphragm constraint: (a) the total mass is computed in the X, Y, and Z 

directions, (b) the center of mass is computed for the story, and (c) the rotational inertia is computed 

about the vertical axis through the story center. To compute the direction factors for each mode, the 

mass-weighted average translational displacements in the X, Y, and Z directions are computed, as 

well as the mass-weighted average Z rotation about the story center of mass. The four direction 

factors for UX, UY, UZ, and RZ are computed as: Di = sum over all stories j (Uij * Mij * Uij), 

where Uij and Mij are the displacement and mass for each direction i = UX, UY, UZ, or RZ at story 

j, and Di is the corresponding direction factor. The new formulation produces identical results for a 

model with all mass included in rigid diaphragm constraints, and generally will provide very similar 

results when the rigid diaphragms constraints are replaced with semi-rigid diaphragms. Direction 

factors are primarily used by the Chinese design code, and provide information about the 

contribution of torsional deformation to each mode. 

Database Tables 
Enhancements Implemented 

* Incident Description 

 56742 An enhancement has been implemented to allow exporting of database tables to an XML file. This 

can be used to export the tables to Microsoft Access when Access is not installed on the machine 

where ETABS 2013 is being run. The exported XML files are in a format that can then be 

imported into Microsoft Access on another machine. 

Open Application Programming Interface 
Enhancements Implemented 

* Incident Description 

 52923 As part of the ongoing enhancement to the Open API, numerous functions that were not available in 

the previous release have now been implemented. Functions that are not yet implemented will 

continue to return code -99. This enhancement process will continue with subsequent releases. 

External Import/Export 
Enhancements Implemented 

* Incident Description 

 44622 An enhancement has been implemented to export the loads due to staged-construction analysis from 

ETABS 2013 to SAFE. Results will be exported for the final step only. Loads applied to objects on 

the slab will include all loads applied in any stage. 

 56576 

57123 

The import of floor plans and 3D models from DXF files has been enhanced as follows: (1) 

AutoCAD polylines with an extra last vertex that was coincident with the first vertex were not being 

imported. They are now imported, and the extra vertex is discarded as not needed in ETABS. (2) 

When importing a DXF file into a blank model, a form is now available to allow adding or 

removing based on the elevations of the points found in the DXF file. When importing a DXF file in 

an existing model, the elevations of the bottom and top story are now adjusted to make sure they 

encompass all points found in the DXF file. (3) Vertical AutoCAD lightweight polylines were being 

imported as horizontal floor objects. Now they are imported as wall objects when they have 

only three or four sides and when the type of import is a 3D model. (4) Horizontal polylines with 

arc sides were being imported as floor objects with straight edges along the chords of the original 

arcs. Now they are imported as floor objects with arc sides. Vertical polylines with arc sides are 

imported with straight edges along the chords of the original arcs to be consistent with ETABS wall 
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* Incident Description 

geometry. (5) Arcs were being imported as a series of short, straight ETABS frame objects. Now 

they are imported as ETABS curved-frame objects. (6) Arcs with an aperture of less than 3 degrees 

were not not being imported. Now such arcs will be imported. (7) Under the Import menu, the the 

command names ".DXF/.DWG File of Floor Plan" and ".DXF/.DWG File of 3D Model" have been 

changed to ".DXF File of Floor Plan" and ".DXF File of 3D Model" since only .DXF files are (and 

were) supported. 

 56578 The import of grid systems from .DXF files has been enhanced as follows: (1) Arcs were being 

imported as a series of short, straight grid segments. Now they are now imported as R-direction 

gridlines of a cylindrical grid system. (2) Arcs with an aperture of less than 3 degrees were not 

being imported. Now such arcs will be imported. (3) Gridline ID's will now be imported when they 

are aligned with a gridline. (4) Lines and arcs will now be sorted into Cartesian grid systems of 

parallel lines and cylindrical systems of concentric arcs and radiating lines, respectively. (5) Under 

the Import menu, the command name ".DXF/.DWG File of Architectural Grids" has been changed 

to ".DXF File of Architectural Grids" since only .DXF files are (and were) supported. 

 57068 Several changes have been made for the import and export to IFC 4 files: (1) Nonprismatic frame 

sections are now supported, provided the type of section (e.g., rectangular) is the same at the start 

and end of the frame section. If the ETABS nonprismatic section has multiple segments, the internal 

sections are ignored and a single segment between the start and end section is assumed. When 

exporting to an IFC 4 structural analysis view files, nonprismatic ETABS frame members are 

exported as IfcMaterialProfileSetUsageTapering, and in the case of an architectural coordination 

view file, as 'Body' IfcShapeRepresentation of type 'AdvancedSweptSolid'. When importing an IFC 

4 structural analysis view or architectural coordination view file, any IfcStructuralCurveMember, 

IfcColumn, IfcBeam, and IfcMember entities with a profile defined by an 

IfcMaterialProfileSetUsageTapering is imported in ETABS as a nonprismatic section.  (2) Floors 

with a deck property are now exported to architectural coordination view files as IfcSlab entities 

with a thickness equal to the total deck thickness. Previously they were exported with a thickness 

equal to the concrete cover thickness. Both thicknesses are an approximation of the deck since IFC 

has no provision for ribbed deck with a concrete cover but the total deck thickness is a better 

approximation for architectural coordination purposes. Additionally, floors with a deck property are 

exported to structural analysis view files as IfcStrucutralSurfaceMember with a 

Membrane_element  predefined type. Previously, they were exported with a Bending_element 

predefined type. Again, both are an approximation of the deck since IFC has no provision for ribbed 

deck with a concrete cover. (3) The temperature unit was incorrectly exported which could result in 

incorrect values of the coefficient of thermal expansion for materials in applications that import 

material properties from IFC. (4) The user now has the option to export only part of an ETABS 

model by selecting members prior to using the IFC export command and choosing the Model 

Selection option in the Create IFC File form.  

 58344 Several enhancements have been made to the import of SDNF files: (1) SDNF version 3.0 files can 

now be imported. Previously, only version 2.0 files could be imported. (2) The Story Data form, 

which is displayed during the import for setting the story-level elevations and names, now supports 

the addition and deletion of individual stories. Previously, the only way to add or delete stories was 

to change the minimum story height in the form, which is still allowed. (3) When ETABS does not a 

recognize a section profile name in the SDNF file,  the Frame Properties form is displayed allowing 

the user define or import a replacement section. Previously, the section profile was imported with 

the unrecognized name and default properties and a warning was issued. The section profile is still 

imported with the unrecognized name and default properties if the user cancels out ot the Frame 

Properties form without specifying a replacement section. (4) Piece marks are now imported as 

frame object unique names. (5) When ETABS encounters a problem reading the SDNF file, the 

warning message displayed now includes the line number of the problematic line. 
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* Incident Description 

 58495 Several enhancements have been made to the import of CIS/2 files: (1) Whenever ETABS 

recognizes the name of a section in the CIS/2 file as a standard section name, it uses the standard 

section properties from the appropriate ETABS XML file even if the section is not defined as being 

standard in the CIS/2 file. This prevents a loss of data when some of the section dimensions, such as 

fillet radii, are missing from the CIS/ file. (2) When a section is defined as standard or when its 

dimensions are not provided in the CIS/2 file, and ETABS cannot find a standard section with the 

CIS/2 section name, the Frame Properties form is displayed allowing the user to define or import a 

replacement section. Previously, the section profile was imported with the unrecognized name and 

default properties if it was declared as a standard section, and with zero dimensions otherwise. The 

section profile is still imported with the unrecognized name and default properties if the user 

cancels out of the Frame Properties form without specifying a replacement section. (3) When a 

section is imported with default properties, this is reported in the log file. (4) Element names are 

imported as frame member unique names. 

Documentation 
Enhancements Implemented 

* Incident Description 

 55714 A new Technical Note has been added to provide details on the features supported for the import 

and export of IFC files. 

 56803 The "Lateral Loads Manual" has been updated for the NBCC 2005 and NBCC 2010 code to 

clarify how the "Program Calculated" time period is computed for braced frames. This was a change 

to the documentation only. No results were affected. 
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User Interface and Display 
Incidents Resolved 

* Incident Description 

 55640 An incident was resolved where selected reference points could not be deleted in the Reference 

Points form unless all points were deleted. This form is accessed using the command Edit > Edit 

Stories and Grid Systems > Modify/Show Grid Systems > Reference Points. 

 56401 An incident was resolved in which ETABS 2013 would sometimes terminate immediately upon 

startup when trying to load the Start Page. This could occur if a corrupt or invalid image file 

used for the Start Page. Deleting the cached Start Page subfolder located in the folder 

%LocalAppData%\Computers and Structures\ETABS 2013\, or setting the option 

ShowStartPage=False in the ETABS 2013.ini file in the same folder would correct this problem. 

 56729 An incident was resolved where the snap option "Snap to Grid Intersections and Points" did not 

appear to work when drawing in an elevation view using the command Draw > Draw Joint Objects. 

The snap option actually did work correctly, but the display of the snap did not work. 

 57226 An incident was resolved where deleting the last group definition would delete all the defined 

groups except for group "All". 

 57428 An incident was resolved where deleting a load pattern that was being used in a shell uniform load 

set could corrupt the shell uniform load set. This could either cause the shell uniform load set to use 

the incorrect load pattern or to generate an exception (runtime error) when performing analysis.  

 57750 An incident was resolved in which the "Moment Frame Beam Type" field was not always available 

on the Assignments tab of the Beam Information right-click form. 

 58379 An incident was resolved for the customization of keyboard shortcuts in which the following items 

were corrected:  (1) When using a number in a shortcut key combination, it displayed as 'D#'. The 

'D' has now been removed to only show the number.  (2) The Ctrl+Shift+F5 shortcut was 

mistakenly assigned to three commands and the Shift+F4 shortcut was mistakenly assigned to two 

commands. The duplicate commands have been changed.  (3) In certain cases, the assigned 

shortcuts could get mixed up and when assigning additional shortcuts unnecessary messages were 

issued indicating that shortcuts were assigned to other commands.  (4) Certain shortcut keys are not 

allowed due to Microsoft limitations; a message is now displayed when attempting to assign an 

invalid shortcut key. 

Graphics and Drafting 
Incidents Resolved 

* Incident Description 

 55667 An incident was resolved where Section Designer sections were not properly shown as extruded 

when extruded views were requested. This was a display issue only, and no results were affected. 

 55809 An incident was resolved where the extruded view of curved beams showed the beams above the 

floor level. This was a display issue only. The model was correct and no results were affected. 

 56602 An incident was resolved where setting the depth for spandrels was not working correctly when 

using the Draw > Draw Floor/Wall Objects > Draw Walls (Plan) command. Spandrels were always 

being drawn over the full floor height. Now spandrels will be drawn with the height specified above 

and below the story level, except at the top story (drawn below the story level only) and at the base 

(spandrels not drawn). 
 56716 

57135 

An incident was resolved where the on-screen drawing of frame objects would not snap when the 

fixed-length option was on. 

 57486 An incident was resolved where the frame section properties automatically created by ETABS when 

converting from an architectural layer could be incorrect. The section dimensions were correct, but 

the areas, moments of inertia, and torsional constant were not always consistent with those 

dimensions. The actual values used were visible in the property definitions and table displays. 

Results were consistent with the values displayed. 
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Modeling 
Incidents Resolved 

* Incident Description 

 55417 An incident was resolved in which auto edge constraints between slabs and walls were not always 

being applied. This error was limited to versions 13.0.0 through 13.1.1, and only occurred when 

there were no beams or columns framing into the wall. 

* 56153 An incident was resolved where replication of frames would sometimes generate duplicate frames 

in the same location. Models that have been affected by this error will automatically delete the 

duplicated frames when the model is opened in the new version, and the user will be notified of this 

correction. Also, the speed of replication has been improved. 

 56786 

57796 

An incident was resolved where in certain special cases an intermediate-level slab associated with a 

story level was incorrectly automeshed. The effect on results was insignificant. 

 57063 An incident was resolved where changing the value of the Modulus of Elasticity (E) for an isotropic 

material property only changed the behavior in the material local-1 direction. The behavior in the 

local-2 direction used the modulus of elasticity in effect when the material was first created. In 

effect, the material behaved as if orthotropic, and the properties actually used could be seen by 

changing the material Directional Symmetry Type to Orthotropic. A similar consideration applied to 

the Poisson's ratio, where changing the u12 value did not affect u13 or u23. This error only affected 

shell objects (walls, floors), not frame objects or rebar material. For most realistic models, the effect 

of this error was small. 

 58763 An incident was resolved for the Australian/New Zealand section database files where (1)  The 

values for section modulus [SX, SY] were switched with the values for plastic modulus [ZX, ZY]. 

(2)   The values for section modulus [SX, SY] were too small by a factor of 1000. These two errors 

affected only HCC, HCB, and HCBC sections.  

Loading 
Incidents Resolved 

* Incident Description 

 56364 An incident was resolved in which the auto-seismic load database tables would indicate the wrong 

direction of load for the NBCC 2005 and NBCC 2010 codes. Also, the Fa and Fv values were also 

always indicated as 1 irrespective of the values defined in the load pattern. These were table 

reporting issues only. The loads applied to the model agreed with the data entered by the user and 

shown on the corresponding form (dialog box). 
 56402 An incident was resolved where the weight property modifier was not being applied to deck type 

shell elements. 

 56624 An incident was resolved in which the Chinese 2010 response spectrum function could not be 

generated due to an "array bound" error when the characteristic period Tg was smaller than 0.2 sec. 

 56715 An incident was resolved where the following items were corrected for Auto Wind loading using 

NBCC 2005 and NBCC 2010 codes: (1) Ce-leeward pressure for rough terrain was being computed 

as (h/12)^0.3 instead of 0.7*(h/12)^0.3. This produced conservative results for NBCC 2005 and 

NBCC 2010 codes. (2) The Area Exposure Method for NBCC 2010 was not activated. This option 

is now available. (3) Chapter 3 of the "Auto lateral Loads" manual has been updated accordingly. 

 57019 An incident was resolved for the Australian and New Zealand AS/NZS 1170.2-2011 wind loading 

codes where two load patterns/cases with no torsion were unnecessarily being generated. The 

number of load patterns/cases generated has now been reduced from six to four.  

 57028 An incident was resolved for auto wind load for the NBCC 95, NBCC2005 and NBCC2010 codes 

where the parameter Cg was being reset to the default value unless it was specified two or more 

times. This has been corrected. 

 57221 

58466 

An incident was resolved for ASCE 7-02/ASCE7-05/ACE7-10 auto wind loading where the wind 

direction angle was not being applied when the model was imported from a text (.E2K, .$ET) file. 

This error only occurred when the wind load was specified for a single ASCE Case (1 to 4), in 

which case the load was always applied in the X direction (Case 1). This error did not affect the 

option "Create All Sets", which correctly applied the load in all four directions. 
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Analysis 
Incidents Resolved 

* Incident Description 

 56220 An incident was resolved where deleting some functions (response-spectrum, time-history) could 

sometimes cause other remaining user-defined functions to no longer work correctly when running 

the analysis. When this occurred, an error message was generated when trying to run the analysis. 

 57144 An incident was resolved where the speed of analysis could be reduced when the mouse was moved 

over the graphical user interface while the analysis was running. This effect was machine-dependent 

and did not affect most installations. Results were not affected in any case. 

 57538 An incident was resolved in which, for certain models imported from a text file, time-history 

functions produced zero results in time-history load cases unless the user first viewed the function 

using the command Define > Functions > Time History > Modify/Show Function and clicked OK.  

Frame Design 
Incidents Resolved 

* Incident Description 

 33430 An incident was resolved for concrete frame design where the "Consider Minimum Eccentricity" 

option in the Design Preferences for ACI 318-08 and ACI 318-11 was not being used. The 

minimum eccentricity was always being enforced regardless of the option chosen, and the 

resulting design results were conservative. 

 52975 An incident was resolved for composite beam design that corrected the following issues for 

specifying bracing in the design overwrites form: (1) For bracing points and uniform bracing 

ranges, lengths specified as absolute were incorrectly being multiplied by the member length. 

Lengths specified as relative were not affected. (2) For bracing lengths in the construction case, 

lengths specified as absolute were incorrectly being multiplied by the member length. Lengths 

specified as relative were not affected. (3) For bracing lengths in the strength case, the form did 

not permit lengths to be specified. 

 54109 An incident was resolved where the D/C ratio for composite beams was sometimes being reported 

as "infinity" for Eurocode 4-2004.  

 54348 An incident was resolved in which duplicate automatic load combinations were being generated 

for the Dead + Seismic load combination, for the Canadian design code CSA S16-09, CSA S16-

09, and CSA S16-95. This did not affect design results. 

 54790 An incident was resolved for steel frame design codes "AISC 360-05" and "AISC 360-10" when 

using the Direct Analysis Method where the analysis model was sometimes not being updated by 

the stiffness modification factors even if the EA and EI had been modified by the frame design 

procedure. This only occurred for members where the frame design procedure had been manually 

overwritten by the user to be Steel Frame Design. It did not affect the most common case where 

the frame design procedure had automatically been set to Steel Frame Design. This error also 

would not affect the results if the stiffness modification option was set to "No Modification". 

 54796 An incident was resolved for steel frame design using the AISC 360-10 code when considering 

Special Concentric Braced Frames (SCBF) where the slenderness was being checked against a 

limit of 0.4*sqrt(E/fy) rather than a limit of 200. 

 54809 An incident has been resolved for concrete frame design using code AS 3600-09 in which a fixed 

value of Alpha_b was being used in the expression of Ast,min while it should have used an 

equation for Alpha_b. Previously Alpha_b was taken as 0.22 for both rectangular and T-beams. 

Now Alpha_b, and hence Ast,min, are being calculated using the equations given in the code (AS 

8.1.6.1). This effect of this error was small; it affected rectangular beams conservatively and T-

beams unconservatively. 

* 55777 

55844 

An incident was resolved where duplicated frame members could cause internal errors during 

frame design that would generate runtime error messages or produce incorrect results. Model files 

opened in the new version will remove the duplicated members and issue a warning message that 

this correction has been made. When this occurs, all frame designs for such models should be re-

run and re-verified. This does not affect most models. 
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* Incident Description 

 55911 An incident was resolved for steel frame design in which the program caused an error message 

while checking tubular sections when the section had a very small cross-sectional area such that 

N.Ed >= N.pl.Rd and either the major or the minor axis bending moment was identically zero. The 

affected codes were Eurocode 3-2005, Italian NTC 2008, and Indian IS 800:2007. 

 56118 An incident was resolved for steel frame design using the AISC 360-05 and AISC 360-10 codes in 

which Omega0 value specified in the design overwrites for a member were correctly used in the 

design, but the reported value was always that from the design preferences.  

 56121 An incident was resolved for steel frame design using the AISC 360-10 and AISC 360-05 codes 

where the D/C ratio reported for box/tube and pipe sections, when plotted on the screen, did not 

always match the value shown in the right-click details and in the tables. The correct values were 

presented in the details and tables; only the graphical display was incorrect. This error occurred for 

box/tube and pipe sections subjected to significant torsion.  

 56156 An incident was resolved for concrete frame design using the ACI 318-11 code where the units for 

longitudinal torsional reinforcement (Al) were incorrect in the design details report. The units used 

for the longitudinal value Al were [area/length] but should instead be [area]. The displayed result 

was incorrect. 

* 56568 An incident was resolved for steel frame design using the CSA S16-09 code where the special 

seismic check was not being performed for braced frame systems when RD > 1.5. Model with 

braced frames with RD > 1.5 should be redesigned with the new version to perform these checks. 

 56571 An incident was resolved for steel frame design using the Eurocode 3-2005 code where the design 

was not checking interaction equations EC3 6.2.3-Eq 6.5 and EC 6.3.1.1-Eq 6.46. The interaction 

equations EC3 6.3.3 that were being checked did not cover the extreme cases when Ae/An << 1 or 

when the torsional buckling mode governed the axial capacity. This error could be unconservative 

in such cases. Now the design considers these two additional equations explicitly as well as EC3 

6.3.3.  

 56968 An incident was resolved for concrete frame design where the value for "Stations Loc" in 

the Column Element Details (Summary) report was reported incorrectly for all design codes when 

the display units were different than the database units. Also, the values "Minimum M2" and 

"Minimum M3" moments were reported incorrectly in the Column Element Details (Summary) 

report for the following codes: BS 8110-97, Hong Kong CP 2004, Singapore CP 65:99, and NZS 

3101-06. These were reporting issues only and no design results were affected. 
 57393 Shear reinforcing design of Concrete Frames using Eurocode 2-2004 and Italian NTC 2008 codes 

has been enhanced by optimizing the theta angle (i..e., angle of compression struts) for columns in 

all ductility classes and for beams in ductility classes Medium and Low. Theta angles for beams 

with seismic load combinations in ductility class "High" are always taken as 45 degrees. 

Previously the theta angle was optimized for concrete beams only without any seismic load 

combinations. 

 57546 

57658 

An incident was resolved for composite column design based on the AISC 360-10 code where the 

capacity of circular-shaped encased sections in the minor direction was sometimes computed as 

zero, resulting in a D/C ratio of infinity in the design report. 

 57581 An incident was resolved for steel frame design using the Indian IS 800:2007 code where the 

design was not checking the individual action equations in Sections 6.1, 7.1.1, 8.2. The interaction 

equations given in Sections 9.3.1.1, 9.3.1.3, 9.3.2.1, and 9.3.2.2 were being checked, as 

appropriate, depending upon the section type and section class (Class 1, 2 and 3). However, in 

certain rare and extreme cases the individual action checks may govern. This has been corrected 

and the output has been improved to provide more information.   

 58115 An incident was resolved for steel frame design using the Eurocode 3-2005 code where the Design 

Overwrites provided an option for overwriting Nc.Rd but the the overwritten values were not 

being used. Now the software uses the overwritten values of NRd for compression in EC3 

6.2.1(7), Nc.Rd in EC3 6.2.4, Npl.Rd for compression in EC3 6.2.9.1, Aeff*fy/GammaM0 for 

compression in EC3 6.2.9.3(2), A*fy/GammaM1 for compression in EC3 6.3.1.1, and 

NRk/GammaM1 for compression in EC3 6.3.3. Similarly the overwritten value for Nt.Rd is used 

for NRd for tension in EC3 6.2.1(7), Nt.Rd in EC3 6.2.3(1), and Npl.Rd for tension in EC3 

6.2.9.1. The axial term NEd/NRk is ignored for tension in EC3 6.3.3.  
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* Incident Description 

 58794 An incident was resolved for steel frame design with the AISC 360-10 or AISC 360-05 codes 

when using the "ASD Design Provision" where load combinations for wind load based on ASCE 7 

section 2.4.1-5 were incorrectly increasing the scale factor on the Super Dead load based on the 

value of Sds. This increase should only be applicable to seismic load combinations. This error only 

affected models with Super Dead loads using the ASD design provision, and was obvious by 

looking at the scale factors used in the load combinations. 

Shear Wall Design 
Incidents Resolved 

* Incident Description 

 55414 

56585 

An incident was resolved for concrete and masonry shear wall design where masonry materials 

could not be selected in the Pier/Spandrel Overwrite form. Now, both concrete and masonry 

materials are available as pier/spandrel overwrites. A masonry material can be assigned to a 

concrete pier and vice-versa. However, piers and spandrels assigned a masonry material (or 

overwrite) will only be designed when the shear wall design preference is set to the ACI 530-11 

masonry code. Similarly, piers and spandrels assigned a concrete material (or overwrite) will only 

be designed when the shear wall design preference is set to a concrete code. 

 56412 An incident was resolved for Eurocode 2-2004 shear wall design that corrected three issues: (1) The 

pier minimum reinforcement was incorrectly enforced as 0.002Ac instead of the larger of 0.001Ac 

and 0.25*Avmin. This previously produced an over-conservative amount of shear rebar. (2) The 

spandrel minimum reinforcement was incorrectly enforced as 0.002 Ac. Now the design uses the 

EC2 Eqn. 9.5N according to the National Annexes of EC2. This previously produced an over-

conservative amount of spandrel shear rebar. (3) The spandrel shear capacity due to longitudinal 

reinforcement was always being computed as zero. This produced an over-conservative design. 

 57264 An incident was resolved where displaying the detailed Pier Design output would generate an error 

when the number of legs at the pier top and bottom were different. This affected all wall design 

codes. This was only a reporting error and design results were not affected. A workaround was 

to relabel the piers to create identical pier legs at the top and bottom. 
 57813 An incident was resolved for shear wall design using the Turkish TS 500-2000 code in which the 

spandrel shear reinforcement was computed using the design preference Gamma (Concrete Shear) 

instead of Gamma (Steel). In addition, spandrel diagonal reinforcement is mandatory when 

span/depth ratio is <= 3 and Vd > 1.5*fctd*d*b. However, the mandatory status for diagonal rebar 

was always shown as "No". This was a reporting issue only and the calculation of diagonal 

reinforcement was actually available in the report. 

Detailing 
Incidents Resolved 

* Incident Description 

 57535 An incident was resolved in which the detailing was not completed for shear walls in certain 

models. 

Results Display and Output 
Incidents Resolved 

* Incident Description 

 56851 An incident was resolved in which the shear wall design results tables for Eurocode 2-2004 were 

not available for inclusion in a report. These tables were available for display and export. 

 57499 An incident was resolved where, for double-valued load combinations, the maximum and minimum 

values were switched for certain pier and spandrel output forces. The correct range of values was 

still being considered in design, so there was no effect on results. 
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* Incident Description 

 57814 An incident was resolved where the plot of diaphragm forces using the command Display > Story 

Response Plots was not accounting for loads acting on internally created points (due to 

automeshing). 

 58860 An incident was resolved where the beam transformed inertia was not being reported for the AISC 

360-10, AISC 360-05 and CSA S16-09 codes. These parameters were being computed correctly and 

design results were not affected. A new section, "Composite Beam Properties", has been added to 

the design report. 

Database Tables 
Incidents Resolved 

* Incident Description 

 54641 An incident was resolved in which the Step column was not displayed in database tables for auto-

lateral loads when the load case and step data fields were requested to be shown in separate columns 

(by default they are shown in a single combined column). This was a reporting issue only and did 

not affect results. 

 55676 An incident was resolved in which the Wall Pier Summary table would sometimes generate an error 

when displayed for a model containing piers that had not been designed. This was a reporting issue 

only and did not affect results. 

 55989 An incident was resolved in which the wall pier design results table would sometimes generate an 

error for walls with uniform reinforcement that were being checked. This was a reporting issue only 

and did not affect results. 

 56341 An incident was resolved in which models from v13.0.0 containing table sets would not always 

maintain the same tables in the table sets when opened in v13.1.0 or v13.1.1. 

 56842 An incident was resolved in which exporting database tables to Microsoft Access and/or Excel was 

not always possible depending on whether 32 or 64-bit Microsoft Office was installed along with 32 

or 64-bit ETABS. This typically only occurred when the two didn't match (i.e. 32-bit Office with 

64-bit ETABS and vice-versa). 

 56962 An incident was resolved in which the "Frame Assignments - Sections" database table would 

sometimes fail to display. This happened when the design procedure of a frame was overwritten. 

This was a table issue only and did not affect results. 

 57113 An incident was resolved in which the Joint Reactions table was unable to be generated when there 

were internally generated points (due to meshing) to be included in the table. This could also cause 

the generation of a report to fail if the report contained this table. 

Data Files (.EDB, .E2K, .$ET) 
Incidents Resolved 

* Incident Description 

 55688 An incident was resolved where certain model files from ETABS v9 could not be opened in ETABS 

2013. This occurred in models where Section Designer sections contained invalid data. This data 

will now be corrected when the model is opened in ETABS 2013. 

 55912 An incident was resolved where the frame section property modifiers were being overwritten and 

set to default when imported from a text model file (.E2K or .$ET). The problem was limited to 

sections that needed to be imported from section-property database files. 

 55987 An incident was resolved where the inch symbol in section properties causes an issue when moduli 

are imported from .E2K or .$ET files. 

 57751 An incident was resolved that corrected two errors that could lead to corruption of the model 

(.EDB) file.  (1) Deleting existing rebar definitions could corrupt the model when it was saved.  (2) 

In certain rare cases the wall design data could be incorrectly read in, causing an exception (runtime 

error) reading the subsequent data. 
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Open Application Programming Interface 
Incidents Resolved 

* Incident Description 

 57170 An incident has been resolved for the Open API where the reference(s) to ETABSObject (and other 

OAPI classes) would get disconnected from ETABS after an idle period of more than 5 minutes 

where no OAPI calls were being made. When this occurred, subsequent OAPI calls caused an 

exception (runtime error). No results were affected. 

External Import/Export 
Incidents Resolved 

* Incident Description 

 27629 An incident was resolved for the export from Revit Structure where the rigid links were not being 

exported to ETABS 2013, and ETABS 2013 joint offsets were not being exported to Revit 

Structure.  

* 33649 

52947 

54178 

54998 

55686 

56775 

56919 

An incident was resolved where force and displacement results from load cases, including response-

spectrum cases, were not being correctly exported to SAFE. The error existed in ETABS 2013 

versions v13.0.0 to v13.1.1. Models previously exported to SAFE from these versions of ETABS 

2013 should be re-verified or re-exported. 

 55443 An error was resolved where models with wall piers defined below the base story level would 

generate an error when running the analysis.  Also corrected a rare text import error that could 

temporarily corrupt the model if you ran the model after importing it and before saving and 

reopening it. 

 55720 An incident was resolved that addressed several issues with the import of STAAD files: (1) 

Notional loads are now imported. (2) Material unit weight and modulus of elasticity were set to 

incorrect values when these values were defined by reference to a type of material and the STAAD 

file was in units other than pound-inches. This did not affect material properties specified using 

explicit values. (3) STAAD node and element names are now imported as ETABS point object, 

frame object, and shell object names so that the names are consistent between the two programs. (4) 

A dash character (-) at the end of a line in the input file was being interpreted as a line continuation 

even when it was not preceded by a blank space. It is now interpreted as a line continuation only 

when preceded by a blank space, unless it is part of a loading title, in which case it is treated as part 

of the loading title and will be imported as a load pattern note. 

 56280 An incident was resolved where command File > Capture Picture > Current Window as DXF/DWG, 

when applied to a plan view of the model, would produce an invalid DXF file. When this occurred, 

the DXF file could not be opened. The DWG file option was not affected. 

 56577 An incident was resolved that addressed several issues with the import of  CSiXRevit EXR files into 

ETABS: (1) One-story steel columns, defined in Revit Structure, did not have their splice points 

properly defined when an .EXR file was imported into ETABS. This caused a problem when the 

ETABS model was exported back to Revit Structure where all the one-story columns at a given grid 

location were merged into a single multi-story column. This error did not affect multi-story steel 

columns defined in Revit Structure, nor did it affect concrete columns, which are always treated as 

being one-story by CSiXRevit when imported into Revit Structure. (2) Walls with a door opening at 

their base that had an arch-shaped top were being imported without the door opening. (3) The Revit 

ID's of walls, floors, wall openings, floor openings, columns, and framing elements are now 

imported into ETABS as frame-object and area-object unique names so that the names are 

consistent between the two products. 

 57070 An incident was resolved that addressed several issues with the export to CIS/2 files: (1) The 

export would cause the software to terminate if the model being exported did not contain any grid 

systems with X- or Y-direction gridlines. (2) The pressure unit was incorrectly defined in the CIS/2 

file when the user selected to write the file in feet, or in millimeters. (3) Results for a 

load case that combined several load patterns were exported as part of a CIS/2 
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* Incident Description 

analysis_results_set_basic instead of an analysis_results_set_combined. Now results for all selected 

load cases are always exported as part of an analysis_results_set combined and the load case is 

defined in terms of load patterns. (4) When results for a load combinations that combined one or 

more load case themselves combining several load patterns were exported, the load combination 

was incorrectly defined. 

 57459 An incident was resolved that addressed several issues with the export of DXF and DWG files: 

(1) The export of a DXF file would not complete if the user did not have write permission to the 

folder where ETABS 2013 was installed. This was due to ETABS attempting to write a temporary 

file in that folder. When this occurred, no DXF file was created. The temporary file is now written 

to the user's Windows temp folder. (2) No DXF or DWG file was created when an elevation mode 

was selected for export. (3) In the 3D mode, ramps would occasionally be exported to DXF or 

DWG files with an incorrect slope. When this occurred, the error was visually obvious. 

Documentation 
Incidents Resolved 

* Incident Description 

 56376 A documentation error has been corrected for the Eurocode 2-2004 Shear Wall Design 

manual where page 2-22 included additional information which was not specific to Eurocode 2-

2004. These additional details have been removed for consistency with other manuals. No results 

are affected. 

Miscellaneous 

* Incident Description 

 55962 The version number was changed to v13.1.2 for a new minor release.  

 


